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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).



Table of Contents

Preface
Product Description. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
About This Publication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Additional Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

Chapter 1
Installation Before You Begin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Connect the Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Connect to the Power Supply. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Turn Printer On  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Printer States. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Install the ClearTools Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Install the Printer and Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Connect to a Computer or Computer Network. . . . . . . . . . . . . .  12
USB Installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12
Network Installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Chapter 2
Control Panel Touch Screen Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Operating the Touch Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Start Display Symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Chapter 3
Load Material Load Media from Roll . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Adjust the Label Sensor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Load the Transfer Ribbon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Set the Feed Path of the Transfer Ribbon. . . . . . . . . . . . . . . . . . . . . . . .  20

Chapter 4
Print Select Media from Product Catalog . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Map the Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22

Chapter 5
Calibration Confirm Print Alignment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Adjust the Print Position/Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Chapter 6
Fault Correction Types of Errors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25
Rockwell Automation Publication 1492-QS003B-EN-P - October 2019 3



Table of Contents
Chapter 7
Maintenance Clean the Print Head . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Clean, Change, or Replace the Print Roller . . . . . . . . . . . . . . . . . . . . . .  28

Appendix A
Media and Transfer Ribbon 
Installation

Media Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
Outside  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
Inside  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Transfer Ribbon Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Outside  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Inside  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
4 Rockwell Automation Publication 1492-QS003B-EN-P - October 2019



Preface

Product Description

The ClearMultiprint™ marking system creates terminal block tags, heat shrink markers, self-laminating wire markers, and 
adhesive labels for use on terminal blocks, wires, cables and other industrial components.

About This Publication

The following publication provides a brief overview of how to install, operate, and maintain the ClearMultiprint 
marking system.

Additional Resources

These documents contain additional information concerning related products from Rockwell Automation.

You can view or download publications at 
http://www.rockwellautomation.com/global/literature-library/overview.page. To order paper copies of technical 
documentation, contact your local Allen-Bradley distributor or Rockwell Automation sales representative.

Resource Description

ClearTools Software User Manual, publication 1492-UM009 Provides installation and user information for ClearTools™ Software

Product Certifications website,
http://www.rockwellautomation.com/global/certification/overview.page

Provides declarations of conformity, certificates, and other certification details.
Rockwell Automation Publication 1492-QS003B-EN-P - October 2019 5

http://www.rockwellautomation.com/global/certification/overview.page
http://www.rockwellautomation.com/global/literature-library/overview.page
message URL http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf
message URL http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1492-um009_-en-p.pdf


Preface
Notes:
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Chapter 1

Installation

Use the following instructions to unpack and install the ClearMultiprint™ marking system.

Before You Begin
• Unpack the ClearMultiprint marking system from the shipping carton.
• Check for any damage.
• Familiarize yourself with the printer.

Table 1 - Printer with Tear-off Plate

Table 2 - Printer Mechanics

Item Description

1 Cover

2 Margin stops

3 Roll retainer

4 Ribbon supply hub

5 Ribbon take-up hub

6 Belt roller

7 Print mechanics

8 Touch screen display

Item Description

1 Label sensor

2 Print head retainer with print head

3 Guides

4 Guide adjustment knob

5 Label adjustment knob

6 Print head lock lever

7 Tear-off plate

8 Print roller

1

2

3

4
5

6
7

8

9

88

1

8

2

3

4

5
67
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Chapter 1   Installation
Table 3 - What’s Included

Connect the Device 

Table 4 - Connections

Connect to the Power Supply

The printer is equipped with a wide area 
power unit for a supply voltage of 
100...240V.

1. Check that the device is switched off.

2. Plug the power cable into the power connection jack (5).

3. Plug the power cable into a grounded socket.

 Quantity Cat. No. Description

1 1492-PRINTCMP ClearMultiprint Marking System

2 Power Cables (North American and European)

1 25 mm (0.98 in.) Ink Ribbon for Terminal Block Tags  
(Cat. No. 1492-PRIBTB) 

1 110 mm (4.33 in.) Ink Ribbon (Cat. No.1492-PRIBLAB)

1 Cardboard Core

1 Black Grooved Roller for Terminal Block Tags (Cat. No.1492-PROLLTB)

1 Green Print Roller for Label Printing (Cat. No. 1492-PROLLLAB)

1 DVD with ClearTools™ Software and Documentation

1 USB Cable

Item Description

1 Power switch

2 USB master ports

3 USB high-speed slave port

4 Ethernet 10/100 Base-T

5 Power connection jack

2

3

4

5

1
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Installation   Chapter 1
Turn Printer On

Table 5 - Power Switch

When all connections are made, follow these steps. 

1. Switch on the printer at the power switch (1).

2. Then the printer performs a system test. 

If successful, the system status Ready displays. If an error occurs during the system test, the symbol Critical Fault  
and type of error are displayed. Use Table 6 to troubleshoot the error.

Printer States

Table 6 - Printer States

Item Description

1 Power switch

State Display Description

Ready The printer is in the ready state and can receive data.

Printing Label Printing Label  
and the number of the printed labels in 
the print job.

The printer is processing an active print job. Data can be transmitted for a new print 
job, the new print job starts when the previous one has finished.

Pause Pause The operator interrupts the printing process.

Correctable Error The Error Type and number of 
labels still to be printed. Display 
updates red.

An error has occurred that the operator can correct without interrupting the print job. 
The print job can be continued after corrected.

Irrecoverable Error The Error Type and number of 
labels still to be printed. Display 
updates red.

An error has occurred that the operator cannot correct without interrupting the print 
job.

Critical Error Critical Fault 
The Error Type.  
Display updates red.

An error that occurs during a system test. Switch off the printer and then on again at 
the power switch. Call Service if the fault occurs persistently. 

Power Save Mode If the printer is not use for a lengthy period, it automatically switches to power save 
mode. To exit power save mode, press the touch screen display.

1

Ready
Rockwell Automation Publication 1492-QS003B-EN-P - October 2019 9



Chapter 1   Installation
Install the ClearTools Software

1. Load the ClearTools™ Software DVD.

2. Click Software.

3. Click ClearTools Software Installation.

4. Click Yes.

5. Click Next.

6. Accept the terms and Click Next. 
10 Rockwell Automation Publication 1492-QS003B-EN-P - October 2019



Installation   Chapter 1
7. Click Typical.

8. Click OK.

9. Click Install.

10. Click Finish.

Install the Printer and Drivers

Installation of the ClearMultiprint marking system is done by the ClearTools Software. Connecting the printer by USB 
or Ethernet port is described in the following steps.
Rockwell Automation Publication 1492-QS003B-EN-P - October 2019 11



Chapter 1   Installation
Connect to a Computer or Computer Network

Use a USB or Ethernet port to connect the printer to your computer.

USB Installation

1. Start the ClearTools Software.

2. From the Tools menu, click Printer Administration>Printer Explorer.

3. Click Add to add the ClearMultiprint marking system.

The following dialog box appears.

4. Click USB to start the printer search.

The search result is displayed in the following dialog box.

5. If no printer was found, click Search to start the search process again.

6. If a printer was found, select the printer and click Add. 

The following dialog box appears.

7. To change the printer name, click Properties. 
12 Rockwell Automation Publication 1492-QS003B-EN-P - October 2019



Installation   Chapter 1
8. Enter the printer name, click OK to confirm.

9. To check the connection to the printer, click Test.

If the printer is connected and accessible, the following dialog box appears.

If the printer is not accessible, for example it is turned off, the following appears.

Network Installation

1. Start the ClearTools Software.

2. From the Tools menu, click Printer Administration>Printer Explorer.

3. Click Add to add the ClearMultiprint marking system.

The following dialog box appears.

4. Click Network.

The following dialog box appears.
Rockwell Automation Publication 1492-QS003B-EN-P - October 2019 13



Chapter 1   Installation
5. To retrieve the IP Address from Printer Display, touch > , scroll through 
the display to find the IP Address.

6. Enter the IP Address and the port of the printer.

If the printer is found, it is displayed in the Printer dialog box

The following is displayed if the printer is not found. For example if the printer is turned off or if there is a network 
connectivity issue.

7. Click Properties to change the printer name.

8. Enter the printer name in the display name field. Click OK to continue.

The changed name is now displayed in the printer dialog box.

9. To check the connection to the printer, click Test.

If the printer is connected and accessible, the following dialog box appears.

If the printer is not accessible, for example because it is turned off, the following dialog box appears.

Ready
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Chapter 2

Control Panel

This chapter describes the touch screen display operation and symbol definitions.

Touch Screen Display

Table 7 - Touch Screen Display

Operating the Touch Screen
•To open a menu item, lightly touch the appropriate symbol.
•To scroll in a list, slide finger up or down on the display.

Start Display Symbols

Table 8 - Start Display Symbols

Item Description

1 Touch Screen Display— indicates the status of the printer and the print job. It also indicates faults 
and shows the printer settings menu.

2 Master USB ports

Symbol Status Function

Ready To off-line Menu

Feeds a blank label

Ready After the end of print job, reprint last label

Printing Label Pause print job

Pause Resume print job

Ready Clear internal memory, last label can no longer be reprinted.

Printing Label Cancel the active print job and delete all print jobs

Pause

2

1
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Chapter 2   Control Panel
Notes:
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Chapter 3

Load Material
The illustrations in this chapter show the components of the printer along with the instructions on how to load label 
media and transfer ribbon.

Load Media from Roll
Figure 1 - Load Media from Roll

1. Turn the ring (2) counterclockwise, so that the arrows point or arrow points to the unlock symbol, and thus release 
the margin stop (1) from the roll retainer (4).

2. Load label roll (3) on the roll retainer (4) in such a way that the printing side of the labels is visible from above. 
– Refer to Media Installation on page 29 in Appendix A.

3. Remount the margin stop (1) and push against the label roll (3) as far as possible. 

4. Turn ring (2) clockwise, so that the arrow points to the lock symbol, and thus fix the margin stop (1) on the roll 
retainer (4).

5. Turn lever (8) counterclockwise to open print head.

6. Position guides (5) by turning the knob (7) so that they are several millimeters wider than the material.

7. Position material below the belt roller (6) and guide it through the print unit.

8. Move guides (5) closely to the edges of the material without clamping the material.

9. Adjust label sensor (9) if applicable 
– See Adjust the Label Sensor on page 18.

10. Verify that correct print roller is inserted 
– Refer to Clean, Change, or Replace the Print Roller on page 28.

11. Press print head retainer down and turn print head lock lever (8) clockwise to lock the print head.

Item Description

1 Margin stop

2 Ring

3 Label roll

4 Roll retainer

5 Guides

6 Belt roller

7 Guide adjustment knob

8 Print head lock lever

9 Label sensor

5

7
8

6

9

2
1

3
4

IMPORTANT Do not apply too much pressure so that the roll does not spin freely.

IMPORTANT Guide material through the print unit below the label sensor.
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Chapter 3   Load Material
Adjust the Label Sensor
Table 9 - Adjust Label Sensor

The label sensor position is marked with a yellow Status Indicator in the sensor retainer.

1. Press the label sensor adjustment knob (1) using a pointed object, so that the knob pops out of the bore of the 
housing.

2. Position the label sensor (3) by turning the sensor adjustment knob (1) so that the sensor can detect the front edge 
of the label in the direction of paper flow or cut-out mark.

3. Push the sensor adjustment knob(1) back into the bore of the housing using a pointed object until it snaps into 
place.

Item Description

1 Sensor adjustment knob

2 Print head lock lever

3 Label sensor

IMPORTANT When the printer is delivered, the label sensor is positioned in the middle of the paper feed. The label sensor must only 
be adjusted if:
• Material with reflex /cut-out marks not in the middle.
• Multi-strip material with an even number of strips.
• Material with irregularly shaped labels are used.

1

3

2
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Load Material   Chapter 3
Load the Transfer Ribbon
Table 10 - Load Transfer Ribbon

1. Turn the lever (6) 
counterclockwise to open the 
print head.

2. Set the guide (1) on both hubs 
to the correct transfer ribbon width.
– Hold hub (5) and unlock the guide (1) by turning it in direction A.
– Slide the guide (1) in direction B and adjust the guide (1) to ribbon width using the scale. 
– Hold the hub (5) and lock the guide (1) by turning it in direction C.

3. Load the transfer ribbon (4) on the hub until it reaches the guide (1). 

4. Make sure that the ribbon is centered on the hub (5) and aligned with the media.

5. Adjust position of the guide (1) on the take-up hub (5) to the width of the ribbon core (3) and push ribbon core 
on the take-up hub (5).

6. Guide transfer ribbon (4) though the printing unit as shown in Appendix A 
– Refer to Transfer Ribbon Installation on page 30.

7. Secure the end of the transfer ribbon (4) to the ribbon core (3) using adhesive tape. Verify counterclockwise 
rotation direction of the transfer ribbon (4) take-up hub (5). 

8. Turn the transfer ribbon take-up hub(5) counterclockwise to smooth out the feed path of the transfer ribbon(4). 

9. Press the print head down and turn the lever (6) clockwise to lock the print head.

Item Description

1 Guide

2 Margin stops

3 Ribbon core

4 Transfer ribbon

5 Hub

6 Lever

7 Label sensor

6

52 431 1

7

C

A

B

1

TIP To wind the ribbon, a ribbon core is needed that must be at least equal in width to the supply ribbon. When changing the 
transfer ribbon, use the empty supply ribbon core for winding the next ribbon.

IMPORTANT Guide transfer ribbon over the label sensor.
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Chapter 3   Load Material
Set the Feed Path of the Transfer Ribbon
Table 11 - Set the Feed Path of the Transfer Ribbon

A wrinkled transfer ribbon can lead to print image errors.

Transfer ribbon deflection can be adjusted to help prevent 
wrinkles.

1. Turn the ribbon adjustment screw (1) with a Torx 
wrench TX10 and observe the ribbon.
– Turn clockwise to tighten the outer edge of the 

transfer ribbon.
– Turn counterclockwise to tighten the inner edge of 

the transfer ribbon.

Item Description

1 Ribbon adjustment screw

1

TIP It is best to do this adjustment during printing.
20 Rockwell Automation Publication 1492-QS003B-EN-P - October 2019



Chapter 4

Print

In this chapter, you select the proper media and map the printer.

Select Media from Product Catalog

1. From the product catalog under the ClearMultiprint™ Folder, double-click the desired marker or label  
(catalog number 1492-MT6X12) from the variant list.

2. Click Automatic.

The consecutive numbering dialog box appears.

3. Enter a start value and end value and click OK. 

EXAMPLE Example shows a start value of 1 and end value of 10.
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Chapter 4   Print
4. For the terminal tags, we recommend that you rotate the text 90° for the best orientation on the terminal block.

5. Press CTRL+A to select all tags. 

6. Click from the tool bar. 

Map the Printer

1. From the File menu, choose Print, or CTRL+P. 

2. From the Printer menu, select the ClearMultiprint name or serial number. 

3. Click Map.

4. Click Print. 

ab

IMPORTANT Print in bold font for the best print quality.

IMPORTANT Map each marker or label the first time before printing.

IMPORTANT To remove terminal block tags, select the arrow button on the printer display to advance.
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Chapter 5

Calibration

Use the following instructions to calibrate alignment and the print position of the ClearMultiprint™ marking system.

Confirm Print Alignment

1. From the product catalog under the ClearMultiprint folder, double-click the desired marker or label  
(example: 1492­MT6X12) from the variant list.

2. Insert maximum number of capital Xs on each tag per the media that are selected for calibration  
(example: 1492­MT6X12).

3. Place five capital Xs in size 8 pt. font on five tags.

4. Select all your tags by using CTRL+A. 

5. Choose bold font.

6. Click Text Orientation 90° from the toolbar.

This selection orients the Xs as shown.

7. From the File menu, click Print, or CTRL+P. 

8. Verify that the tag or label has been mapped to the printer.

9. Click Print.

10. Visually check tags for proper alignment, if calibration is needed proceed to Adjust the Print Position/Calibration.

IMPORTANT It is recommended to fill each individual tag with “Xs”.
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Chapter 5   Calibration
24 Rockwell Automation Publication 1492-QS003B-EN-P - October 2019

Adjust the Print Position/Calibration

1. To view the calibration settings, click the Information tab at the bottom of the screen.

2. Click Edit.

3. Click the ellipsis. 

4. Visually check the printed tag and see where the "Xs" are in relationship to the tag.
– If your "Xs" are shifted down on the tag, see Figure A.
– If your "Xs" are shifted up on the tag, see Figure B.
– If your "Xs" are shifted right on the tag, see Figure C.
– If your "Xs" are shifted left on the tag, see Figure D.

IMPORTANT The print position measurements are shown in millimeters, and the values correspond to actual position on the label.



Chapter 6

Fault Correction

Use the following instructions to diagnosis and troubleshoot errors.

Types of Errors

The diagnostic system indicates on the touch screen display if an error has occurred. The printer is set into one of the 
three possible error states according to the type of error.

Troubleshooting

State Display Button

Correctable Error Continue, Cancel 
Display updates Red

Irrecoverable Error Cancel
Display updates Red

Critical Fault Cancel 
Display updates Red

Problem Cause Solution

Print image has smears or voids. Print head is dirty. Clean the print head. 

Temperature too high. Decrease the temperature using the driver.

Unsuitable combination of labels and transfer ribbon. Use different type of ribbon.

The printer conveys the labeling material but not the ribbon. The diameter of the cardboard core in use is too large. Use a cardboard core with a smaller diameter.

Printer only prints every other label. The format setting in the driver is too large. Change the format setting in the driver.

The transfer ribbon wrinkles. Transfer ribbon feed path not adjusted. Adjust transfer ribbon feed path.

Vertical white lines in the print image. Print head is dirty. Clean the print head.

Print head is defective. Contact Rockwell Automation®.
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Chapter 6   Fault Correction
Notes:
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Chapter 7

Maintenance

Proper maintenance and regular print head cleaning are required to provide a consistently good printed image and to 
reduces print head wear.

Clean the Print Head

Clean the print head for every ribbon roll change. Substances can accumulate on the print head during printing and 
adversely affect printing.

1. Lift the print head.

2. Remove the labels and transfer ribbon from the printer.

3. Clean the print head line with rubbing alcohol and soft cloth.

4. Allow the print head to dry for two to three minutes before 
commissioning the printer.

ATTENTION: Improper handling can cause print head damage. Do not touch the underside of the print head with the fingers or 
sharp objects. Confirm that the labels are clean.

SHOCK HAZARD: Disconnect the printer from the power supply before performing any maintenance.

IMPORTANT • Abrasive cleansers can damage the print head. Do not use abrasive cleaners or solvents for cleaning the external surfaces or 
modules.

• Remove dust and paper fluff from the print area with a soft brush or vacuum cleaner.
• The cover of the printer can be cleaned with a standard cleanser.

IMPORTANT Damage to the print head can result from contact with the protective glass layer or the use of sharp or hard objects to clean the 
print head

ATTENTION: There is a risk of injury from the hot print head line. Check that the print head has cooled down before starting to 
clean it.

Print head line
Rockwell Automation Publication 1492-QS003B-EN-P - October 2019 27



Chapter 7   Maintenance
Clean, Change, or Replace the Print Roller

Accumulations of dirt on the print roller can impair 
the media transport and the print quality.

Figure 2 - Clean, Change, or Replace the Print Roller

1. Turn the lever (2) counterclockwise to open the 
print head.

2. Remove the material and transfer ribbon from the 
printer.

3. Fold down the cover with the tear-off plate.

4. Lift the print roller (4) from its retainers(3).

5. Remove the deposits with the roller and clean with a
soft cloth. Replace the roller if it appears damaged.

6. Push the roller with bearings (1) into the retainer (3) 
until they click into place.

7. Fold up the cover with the tear-off plate.

EEE Yönetmeliðine Uygundur. (In Conformity with the EEE Regulation)

Battery Notice: This product contains Perchlorate material. Special handling may apply. For more information, go to 
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/.

Item Description

1 Roller with bearing

2 Print head lock lever

3 Retainers

4 Print roller

5 Cover

• At the end of its life, this equipment should be collected separately from any unsorted municipal waste.
• This product contains a sealed lithium battery which is permanently connected and should only be removed or replaced by 

trained professionals. 
• At the end of its life, the battery contained in this product should be collected separately from any unsorted municipal waste. 

The collection and recycling of batteries helps protect the environment and contributes to the conservation of natural resources 
as valuable materials are recovered.

1

2

43 35

Roller for Terminal Block Tags (catalog number 1492-PROLLTB)

Roller for Label Printing (catalog number 1492-PROLLLAB)
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Appendix A

Media and Transfer Ribbon Installation

Media Installation

Outside 

Inside 
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Appendix A   Media and Transfer Ribbon Installation
Transfer Ribbon Installation

Outside 

60 mm (2.36 in.) ribbon for heat shrink (Cat.No. 1492-PRIBHS)

Inside 

25 mm (0.98 in.) ribbon for terminal block tags (catalog number 1492-PRIBTB) 
110 mm (4.33 in.) ribbon for labels (catalog number 1492-PRIBLAB)
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Rockwell Automation Support
Use the following resources to access support information.

Documentation Feedback
Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the 
How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, User 
Forums, and Product Notification Updates. https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone Numbers Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the code to 
route your call directly to a technical support engineer. http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data. http://www.rockwellautomation.com/global/literature-library/overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated firmware. http://www.rockwellautomation.com/global/support/pcdc.page 

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Allen-Bradley, ClearMultiprint, ClearTools, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.
Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Automation maintains current product environmental information on its website at http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
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